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Manage Circuits
This chapter explains how to manage Cisco ONS 15454 SDH electrical, OC-N, and Ethernet circuits. It
also explains how to manage optical channel network connections provisioned in DWDM networks.

Note

Except where noted, the procedures and tasks in this chapter apply to both DWDM (Software Release
4.5) and non-DWDM (Software R4.1 and earlier) nodes.

Before You Begin
To create circuits, see Chapter 8, “Create Circuits and Low-Order Tunnels.”
To clear any alarm or trouble conditions, refer to the Cisco ONS 15454 SDH Troubleshooting Guide.
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).
1.

NTP-D199 Locate and View Circuits, page 11-2—Complete as needed.

2.

NTP-D200 View Cross-Connect Card Resource Usage, page 11-10—Complete as needed.

3.

NTP-D151 Modify Circuit Characteristics, page 11-11—Complete as needed to edit a circuit name,
change the active and standby colors of spans, or change signal fail, signal degrade thresholds,
reversion time, and payload defect indication-path (PDI-P) settings for subnetwork connection
protection (SNCP) ring circuits.

4.

NTP-D152 Delete Circuits, page 11-16—Complete as needed.

5.

NTP-D78 Create a Monitor Circuit, page 11-17—Complete as needed to monitor traffic on primary
bidirectional circuits.

6.

NTP-D79 Create a J1 or J2 Path Trace, page 11-19—Complete as needed to monitor interruptions
or changes to circuit traffic.
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NTP-D199 Locate and View Circuits
Purpose

This procedure provides tasks that you can use to locate and view
ONS 15454 SDH circuits.

Tools/Equipment

None

Prerequisite Procedures Circuit creation procedure(s) in Chapter 8, “Create Circuits and
Low-Order Tunnels.”
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Step 1

Log into the network where you want to view the circuits. See the “DLP-D60 Log into CTC” task on
page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2

As needed, complete the “DLP-D370 View Circuit Information” task on page 11-2.

Step 3

As needed, complete the “DLP-D131 Search for Circuits” task on page 11-6.

Step 4

As needed, complete the “DLP-D262 Filter the Display of Circuits” task on page 11-7.

Step 5

As needed, complete the “DLP-D229 View Circuits on a Span” task on page 11-8.

Step 6

As needed, complete the “DLP-D371 View the MS-SPRing Squelch Table” task on page 11-9.
Stop. You have completed this procedure.

DLP-D370 View Circuit Information
Purpose

This task provides information about ONS 15454 SDH circuits and
DWDM optical channel network connections.

Tools/Equipment

None

Prerequisite Procedures DLP-D60 Log into CTC, page 3-23

Step 1

Step 2

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Navigate to the appropriate CTC view:
•

To view circuits for an entire network, from the View menu, choose Go to Network View.

•

To view circuits that originate, terminate, or pass through a specific node, from the View menu,
choose Go to Other Node, then choose the node you want to search and click OK.

•

To view circuits that originate, terminate, or pass through a specific card, in node view, double-click
the card containing the circuits you want to view.

Click the Circuits tab.
The Release 4.1 Circuits tab has the following information:
•

Name—Name of the circuit. The circuit name can be manually assigned or automatically generated.
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•

Type—Circuit types are: HOH (high-order circuit), LOH (low-order circuit), VCT (VC low-order
tunnel), or VCA (VC low-order aggregation point).

•

Size—Circuit size. Low-order circuits are VC12 and VC3. High-order circuit sizes are VC4,
VC4-3c, VC4-4c, VC4-8c, VC4-16c, and VC4-64c.

•

Protection—The type of circuit protection. See Table 11-1 for a list of protection types.

Table 11-1

Circuit Protection Types

Protection Type

Description

—

Circuit protection is not applicable.

2F MS-SPR

Circuit is protected by a two-fiber multiplex section-shared protection ring
(MS-SPRing).

4F MS-SPR

Circuit is protected by a four-fiber MS-SPRing.

MS-SPR

Circuit is protected by both a two-fiber and a four-fiber MS-SPRing.

SNCP

Circuit is protected by an SNCP.

SNCP-DRI

The circuit is protected by a SNCP dual-ring interconnection.

1+1

Circuit is protected by a 1+1 protection group.

Y-Cable

The circuit is protected by a transponder or muxponder card Y-cable protection
group.

Splitter

(Release 4.5 only) The circuit is protected by the protect transponder
(TXPP_MR_2.5G) splitter protection.

protected

Circuit is protected by diverse SDH topologies, for example, an MS-SPRing and an
SNCP, or an SNCP and a 1+1 protection group.

2F-PCA

Circuit is routed on a protection channel access path on a two-fiber MS-SPRing;
protection channel access (PCA) circuits are unprotected.

4F-PCA

Circuit is routed on a protection channel access path on a four-fiber MS-SPRing;
PCA circuits are unprotected.

PCA

Circuit is routed on a protection channel access path on both two-fiber and 4-fiber
MS-SPRings; PCA circuits are unprotected.

unprot (black)

Circuit is not protected.

unprot (red)

Circuit created as a fully protected circuit is no longer protected due to a system
change, such as a traffic switch.

unknown

Circuit protection types appear in the Protection column only when all circuit
components are known, that is, when the circuit status is ACTIVE or
UPGRADABLE. If the circuit is in some other status, protection type is displayed
as “unknown.”

•

Direction—The circuit direction, either two-way or one-way.

•

Status—The circuit status. Table 11-2 lists the circuit statuses that might appear.
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Table 11-2

Cisco ONS 15454 SDH Circuit Status

Status

Definition/Activity

CREATING

CTC is creating a circuit.

ACTIVE

CTC created a circuit. All components are in place and a
complete path exists from the circuit source to the circuit
destination.

DELETING

CTC is deleting a circuit.

INCOMPLETE

A CTC-created circuit is missing a cross-connect or network
span; a complete path from source to destination(s) does not
exist, or an Alarm Interface Panel (AIP) change occurred on
one of the circuit nodes and the circuit is in need of repair.
(AIPs store the node MAC address.)
In CTC, circuits are represented using cross-connects and
network spans. If a network span is missing from a circuit,
the circuit status is INCOMPLETE. However, an
INCOMPLETE status does not necessarily mean a circuit
traffic failure has occurred, for traffic might flow on a protect
path.
Network spans are in one of two states: up or down. On CTC
circuit and network maps, up spans are displayed as green
lines, and down spans are displayed as gray lines. If a failure
occurs on a network span during a CTC session, the span
remains on the network map but its color changes to gray to
indicate that the span is down. If you restart your CTC
session while the failure is active, the new CTC session
cannot discover the span and its span line does not display on
the network map.
Subsequently, circuits routed on a network span that goes
down display as ACTIVE during the current CTC session,
but they display as INCOMPLETE to users who log in after
the span failure. This status is not displayed for OCHNC
circuit types.

•

Source—The circuit source in the format: node/slot/port “port name”
virtual_container/tributary_unit_group/tributary_unit_group/virtual_container. (The port name
appears in quotes.) Node and slot always display; port “port
name”/virtual_container/tributary_unit_group/tributary_unit_group/virtual_container might
display, depending on the source card, circuit type, and whether a name is assigned to the port. If
the circuit size is a concatenated size (4-2c 4-4c, 4-8c, etc.) VCs used in the circuit are indicated by
an ellipsis, for example, “VC7..9” (VCs 7, 8, and 9) or VC10..12 (VC 10, 11, and 12).

•

Destination—The circuit destination in same format (node/slot/port “port
name”/virtual_container/tributary_unit_group) as the circuit source.

•

# of VLANS—The number of VLANS used by an Ethernet circuit with end points on E Series
Ethernet cards in single card or multicard mode.

•

# of Spans—The number of inter-node links that constitute the circuit. Right-clicking the column
displays a shortcut menu from which you can choose to show or hide circuit span detail.
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•

State—The circuit state. Table 11-3 lists the circuit states that might appear.

Table 11-3

Cisco ONS 15454 SDH Circuit States

State

Definition

IS

In service; able to carry traffic.

OOS

Out of service; unable to carry traffic. This status is not displayed for OCHNC
circuit types.

OOS-AINS

Out of service, auto in service; alarm reporting is suppressed, but traffic is carried
and loopbacks are allowed. Raised fault conditions, whether their alarms are
reported or not, can be retrieved on the CTC Conditions tab or by using the TL1
RTRV-COND command. VT circuits generally switch to IS when source and
destination ports are IS, OOS_AINS, or OOS_MT regardless of whether a physical
signal is present. STS circuits switch to IS when a signal is received. This status is
not displayed for OCHNC circuit types.

OOS-MT

Out of service, maintenance; alarm reporting is suppressed, but traffic is carried and
loopbacks are allowed. Raised fault conditions, whether their alarms are reported or
not, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND
command. This status is not displayed for OCHNC circuit types.

The Release 4.5 Circuits tab has the following information:
•

Name—Name of the circuit. The circuit name can be manually assigned or automatically generated.

•

Type—Circuit types are: HOH (high-order circuit), LOH (low-order circuit), VCT (VC low-order
tunnel), VCA (VC low-order aggregation point), or OCHNC (DWDM optical channel network
connection).

•

Size—Circuit size. Low-order circuits are VC12 and VC3. High-order circuit sizes are VC4,
VC4-3c, VC4-4c, VC4-8c, VC4-16c, VC4-64c. OCHNC sizes are Equipped not specific, Multi-rate,
2.5 Gb/s No FEC (forward error correction), 2.5 Gb/s FEC, 10 Gb/s No FEC, and 10 Gb/s FEC.

•

OCHNC Wlen—For OCHNCs, the wavelength provisioned for the optical channel network
connection. See Table 5-5 on page 5-8 for a list of channels and wavelengths.

•

Direction—The circuit direction, either two-way or one-way.

•

OCHNC Dir—For OCHNCs, the direction of the optical channel network connection, either east to
west or west to west.

•

Protection—The type of circuit protection. See Table 11-1 on page 11-3 for a list of protection
types.

•

Status—The circuit status. Table 11-2 on page 11-4 lists the circuit statuses that might appear.

•

Source—The circuit source in the format: node/slot/port “port name” virtual_container/tributary_
unit_group/tributary_unit_group/virtual_container. (The port name appears in quotes.) Node and
slot always display; port “port name”/virtual_container/tributary_unit_group/tributary_unit
group/virtual_container might display, depending on the source card, circuit type, and whether a
name is assigned to the port. If the circuit size is a concatenated size (4-2c 4-4c, 4-8c, etc.) VCs used
in the circuit are indicated by an ellipsis, for example, “VC7..9” (VCs 7, 8, and 9) or VC10..12 (VC
10, 11, and 12).

•

Destination—The circuit destination in same format (node/slot/port “port
name”/virtual_container/tributary_unit_group) as the circuit source.
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Step 3

•

# of VLANS—The number of VLANS used by an Ethernet circuit with end points on E Series
Ethernet cards in single card or multicard mode.

•

# of Spans—The number of inter-node links that constitute the circuit. Right-clicking the column
displays a shortcut menu from which you can choose to show or hide circuit span detail.

•

State—The circuit state.Table 11-3 on page 11-5 lists the circuit states that might appear.

Return to your originating procedures.

DLP-D131 Search for Circuits
Purpose

This task searches for an ONS 15454 SDH circuit at the network, node, or
card level.

Tools/Equipment

None

Prerequisite Procedures DLP-D60 Log into CTC, page 3-23

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Navigate to the appropriate CTC view:
•

To search the entire network, from the View menu, choose Go to Network View.

•

To search for circuits that originate, terminate, or pass through a specific node, from the View menu,
choose Go to Other Node, then choose the node you want to search and click OK.

•

To search for circuits that originate, terminate, or pass through a specific card, double-click the card
on the shelf graphic in node view to display the card in card view.

Step 2

Click the Circuits tab.

Step 3

If you are in node or card view, choose the scope for the search in the Scope drop-down menu.

Step 4

Click Search.

Step 5

In the Circuit Name Search dialog box, complete the following:
•

Find What—Enter the text of the circuit name you want to find.

•

Match Whole Word Only—Select this check box to instruct CTC to select circuits only if the entire
word matches the text in the Find What field.

•

Match Case—Select this check box to instruct CTC to select circuits only when the capitalization
matches the capitalization entered in the Find What field.

•

Direction—Choose the direction for the search. Searches are conducted up or down from the
currently selected circuit.

Step 6

Click Find Next. If a match is found, click Find Next again to find the next circuit.

Step 7

Repeat Steps 5 to 6 until you are finished, then click Cancel.

Step 8

Return to your originating procedure (NTP).
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DLP-D262 Filter the Display of Circuits
Purpose

This task filters the display of circuits in the ONS 15454 SDH network,
node, or card view Circuits window based on circuit name, size, type,
direction, and other attributes.

Tools/Equipment

None

Prerequisite Procedures DLP-D60 Log into CTC, page 3-23

Step 1

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Navigate to the appropriate CTC view:
•

To filter network circuits, from the View menu, choose Go to Network View.

•

To filter circuits that originate, terminate, or pass through a specific node, from the View menu,
choose Go to Other Node, then choose the node you want to search and click OK.

•

To filter circuits that originate, terminate, or pass through a specific card, double-click the card on
the shelf graphic in node view to display the card in card view.

Step 2

Click the Circuits tab.

Step 3

Set the attributes for filtering the circuit display:
a.

Click Filter.

b.

In the Filter Dialog, set the filter attributes by choosing one of the following:
– Name—Enter a complete or partial circuit name to filter circuits based on circuit name;

otherwise leave the field blank.
– Direction—Choose one: Any (direction not used to filter circuits), 1-way (display only one-way

circuits), or 2-way (display only two-way circuits).
– OCHNC Dir—(DWDM optical channel network connections only) Choose one: East to West

(displays only east-to-west circuits); West to East (displays only west-to-east circuits).
– OCHNC Wlen—(DWDM optical channel network connections only) Choose an OCHNC

wavelength to filter the circuits. For example, choosing 1530.33 displays channels provisioned
on the 1530.33 nm wavelength.
– Status—Choose one: Any (status not used to filter circuits), Active (display only active circuits;

optical channel network connections have Active status only), Incomplete (display only
incomplete circuits, that is, circuits missing a connection or span to form a complete path), or
Upgradable (display only upgradable circuits, that is, circuits created in TL1 that are ready to
upgrade in CTC). See Table 11-2 on page 11-4 for more information about circuit statuses.
(While other statuses are described in the table, filtering is only supported for Active,
Incomplete, and Upgradable circuits.)
– State—Choose one: OOS (display only out-of-service circuits), IS (display only in-service

circuits; optical channel network connections have IS status only), OOS-AINS (display only
out-of-service, auto in-service circuits), or OOS-MT (display only out-of-service, maintenance
circuits.) See Table 11-3 on page 11-5 for more information about circuit states.
– Slot—Enter a slot number to filter circuits based on the source or destination slot; otherwise

leave the field blank.
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– Port—Enter a port number to filter circuits based on the source or destination port; otherwise

leave the field blank.
– Type—Choose one: Any (type not used to filter circuits), HO_PATH_CIRCUIT (displays only

VC4 circuits), LO_PATH_CIRCUIT (displays only VC3 and VC12 circuits),
LO_PATH_TUNNEL (displays only low-order tunnels), LO_PATH_AGGREGATION
(displays only log-order aggregation points), or OCHNC (displays only optical channel
network connections; Release 4.5 only).
– Size—Click the appropriate check boxes to filter circuits based on size: VC12, VC3, VC4,

VC4-2c, VC4-3c, VC4-6c, VC4-8c, VC4-16c, 2.5 Gb/s FEC, multi-rate, Equipment not
specific, 2.5 Gb/s No FEC, 10 Gb/s FEC, 10 Gb/s No FEC. The check boxes displayed depend
on what you entered in the Type field. If you chose Any, all sizes are available. If you chose
LO_PATH_CIRCUIT, only VC3 and VC12 sizes are available. If you chose
LO_PATH_CIRCUIT, only VC4 sizes are available, and if you chose LO_PATH_TUNNEL or
LO_PATH_AGGREGATION, only VC4 is available. If you chose OCHNC as the circuit type,
2.5 Gb/s FEC, multi-rate, Equipment not specific, 2.5 Gb/s No FEC, 10 Gb/s FEC, 10 Gb/s No
FEC are displayed.
Step 4

Click OK. Circuits matching the attributes in the Filter Circuits dialog box are displayed in the Circuits
window.

Step 5

To turn filtering off, click the Filter icon in the lower right corner of the Circuits window. Click the icon
again to turn filtering on, and click the Filter button to change the filter attributes.

Step 6

Return to your originating procedure (NTP).

DLP-D229 View Circuits on a Span
Purpose

This task provides circuits on an ONS 15454 SDH span.

Tools/Equipment

None

Prerequisite Procedures Circuits must be created on the span. See Chapter 8, “Create Circuits and
Low-Order Tunnels.”
DLP-D60 Log into CTC, page 3-23
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Step 1

From the View menu on the node view, choose Go to Network View. If you are already in network view,
go to Step 2.

Step 2

Right-click the green line containing the circuits you want to view and choose one of the following:
•

Circuits—To view MS-SPRing, SNCP ring, 1+1, or unprotected circuits on the span.

•

PCA Circuits—To view circuits routed on a MS-SPRing protected channel. (This option does not
display if the span you right-clicked is not a MS-SPRing span.)

In the Circuits on Span dialog box, you can view the following information about the circuits that
traverse the span. The information displayed depends on the circuit type.
For low-order and high-order circuits provisioned on the span, the following information appears:
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•

VC4—VC4s used by the circuits.

•

VC3—VC3s used by the circuits.

•

VC12—VC12s used by the circuits

•

SNCP—(SNCP span only) If checked, SNCP circuits are on the span.

•

Circuit—Displays the circuit name.

•

Switch State—(SNCP span only) Displays the switch state of the circuit, that is, whether any span
switches are active. For SNCP spans, switch types include: CLEAR (no spans are switched),
MANUAL (a manual switch is active), FORCE (a force switch is active), and LOCKOUT OF
PROTECTION (a span lock out is active).

Note

You can perform other procedures from the Circuits on Span dialog box. If the span is in an
SNCP, you can switch the span traffic. See the “DLP-D197 Initiate an SNCP Force Switch” task
on page 16-17 for instructions. If you want to edit a circuit on the span, double-click the circuit.
See the “DLP-D231 Edit a Circuit Name” task on page 11-13 or the “DLP-D233 Edit SNCP
Circuit Path Selectors” task on page 11-14 for instructions.

For DWDM optical channel network connections, the following information appears:

Step 3

•

OCHNC Wavelength—The wavelength provisioned for the optical channel network connection

•

OCHNC Dir—The direction provisioned for the optical channel network connection, either
east-to-west or west-to-east

•

Circuit—The optical channel network connection circuit name

Return to your originating procedure (NTP).

DLP-D371 View the MS-SPRing Squelch Table
Purpose

This task allows you to view the MS-SPRing squelch table for an
ONS 15454 SDH MS-SPRing node. The table shows VC4s that will be
squelched for every isolated node. The VC4s are replaced by the
appropriate path alarm indication signal (AIS) to prevent misconnections.

Tools/Equipment

None

Prerequisite Procedures DLP-D60 Log into CTC, page 3-23
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Step 1

In node view, click the Provisioning > MS-SPR tabs.

Step 2

Click Squelch Table . In the MS-SPR Squelch Table window you can view the following information:
•

VC Number—Shows the MS-SPRing VC4 numbers.

•

West Source—If traffic is received by the node on its west span, the MS-SPRing node ID of the
source is displayed. (To view the MS-SPRing node IDs for all nodes in the ring, click Ring Map.)
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•

West Dest—If traffic is sent on the node’s west span, the MS-SPRing node ID of the destination is
displayed.

•

East Source—If traffic is received by the node on its east span, the MS-SPRing node ID of the source
is displayed.

•

East Dest—If traffic is sent on the node’s east span, the MS-SPRing node ID of the destination is
displayed.

Note

Step 3

MS-SPRing squelching is performed on VC4s that carry high-order circuits only. VC4s carrying
low-order or stitched Ethernet circuits do not have entries in the squelch table.

Return to your originating procedure (NTP).

NTP-D200 View Cross-Connect Card Resource Usage
Purpose

This procedure provides the percentage of cross-connect card resources
used by circuits that traverse or terminate at an ONS 15454 SDH. This
procedure does not apply to DWDM (Software R4.5) nodes.

Tools/Equipment

None

Prerequisite Procedures None
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Retrieve or higher

Step 1

Complete the “DLP-D60 Log into CTC” task on page 3-23 at the node where you want to view the
corss-connect card resource usage. If you are already logged in, continue with Step 2.

Step 2

Click the Maintenance > Cross-Connect > Resource Usage tabs.

Step 3

In the Summary section of the Resources Usage tab, view the following information:
•

VC4 Matrix— (XC10G, XCVXL 10G, and XCVXL 2.5G cards) Provides the percent of VC-4 paths
and VC-4s dropped to lower order paths that are used. 384 VC-4s are available with XC10G and
XCVXL 10G cross-connect cards; 192 with XCVXL 2.5G cards.

•

TUG3 Matrix Ports—(XCVXL 10G and XCVXL 2.5G only) Provides the percent of the
cross-connect card TUG3 matrix ports that are used. TUG3 matrix ports are the number of VC-4s
that are dropped to lower order paths (using TUG3s to hold VC-3s and TUG2s) shown in VC-4 size.
384 TUG3 matrix ports are available.

•

TUG3 Matrix—(XCVXL 10G and XCVXL 2.5G only) Provides the percent of the TUG-3 matrix
resources that are used. 384 TUG-3 paths are available.

•

VC12 Matrix Ports—(XCVXL 10G and XCVXL 2.5G only) Provides the percent of the VC-12
matrix ports that are used. VC-12 matrix ports are the number of TUG-3s used to support TUG-2s
(i.e., VC-11s and VC-12s, though only VC-12s are supported in this release). 96 VC-12 matrix ports
are available.

•

VC12 Matrix—(XCVXL 10G and XCVXL 2.5G only) Provides the percent of the VT matrix
resources that are used. 2016 VC-12 paths are available.
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Stop. You have completed this procedure.

NTP-D151 Modify Circuit Characteristics
Purpose

This procedure provides tasks that you can use to edit or change the
properties of ONS 15454 SDH circuits and DWDM optical channel
network connections.

Tools/Equipment

None

Prerequisite Procedures Circuits must exist on the network. See Chapter 8, “Create Circuits and
Low-Order Tunnels” for circuit creation procedures.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Log into the network containing the circuit you want to modify. See the “DLP-D60 Log into CTC” task
on page 3-23 for instructions. If you are already logged in, go to Step 2.

Step 2

As needed, complete the “DLP-D230 Change a Circuit State” task on page 11-11.

Step 3

As needed, complete the “DLP-D231 Edit a Circuit Name” task on page 11-13.

Step 4

As needed, complete the “DLP-D232 Change Active and Standby Span Color” task on page 11-13.

Step 5

As needed, complete the “DLP-D233 Edit SNCP Circuit Path Selectors” task on page 11-14.

Step 6

As needed, complete the “DLP-D263 Edit SNCP Dual Ring Interconnect Circuit Hold-Off Timer” task
on page 11-16.
Stop. You have completed this procedure.

DLP-D230 Change a Circuit State
Purpose

This task changes the state of a circuit. This task does not apply to DWDM
(Software R4.5) nodes because optical channel network connections are
always in IS state.

Tools/Equipment

None

Prerequisite Procedures DLP-D60 Log into CTC, page 3-23
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Click the Circuits tab.

Step 2

Click the circuit with the state you want to change.
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Note

You cannot edit the circuit state if the circuit is routed to nodes with a CTC software release older
than Release 3.4. These circuits are automatically in service (IS).

Step 3

From the Tools menu, choose Circuits > Set Circuit State.

Step 4

In the Set Circuit State dialog box (Figure 11-1) change the circuit state by choosing one of the following
choices from the Target Circuit State drop-down menu:
•

IS—Places the circuit in service.

•

OOS—Places the circuit out of service.

•

OOS-AINS—Places the circuit out of service, auto in service.

•

OOS-MT—Places the circuit out of service, maintenance.

See Table 11-3 on page 11-5 for additional information about circuit states.
Figure 11-1 Changing Circuit State

Step 5

If you want to apply the state to the circuit source and destination ports, check the Apply to Drop Ports
check box.

Step 6

Click OK.

Note

Step 7

CTC does not change the state of the circuit source and destination port in certain circumstances.
For example, if the circuit size is smaller than the port, for example, a VC3 circuit on an VC4
port, CTC does not change the port state from IS to OOS. If CTC cannot change the port state,
a message is displayed and you need to change the port state manually.

Return to your originating procedure (NTP).
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DLP-D231 Edit a Circuit Name
Purpose

This task edits a circuit or DWDM optical channel network connection
name.

Tools/Equipment

None

Prerequisite Procedures DLP-D60 Log into CTC, page 3-23
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Click the Circuits tab.

Step 2

Click the circuit you want to rename, then click Edit.

Step 3

On the General tab, click the Name field and edit or rename the circuit. Names can be up to
48 alphanumeric and/or special characters.

Note

If you will create a monitor circuit on this circuit, do not make the name longer than
44 characters because monitor circuits add “_MON” (four characters) to the circuit name.

Step 4

Click Apply.

Step 5

From File menu, select Close.

Step 6

In the Circuits window, verify that the circuit was correctly renamed.

Step 7

Return to your originating procedure (NTP).

DLP-D232 Change Active and Standby Span Color
Purpose

This task changes the color of active (working) and standby (protect)
circuit spans displayed on the detailed circuit map of the Edit Circuits
window. By default, working spans are green and protect spans are purple.
This task does not apply to DWDM(Software R4.5) nodes.

Tools/Equipment

None

Prerequisite Procedures DLP-D60 Log into CTC, page 3-23
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

From the Edit menu, choose Preferences.

Step 2

In the Preferences dialog box, click the Circuit tab.

Step 3

Complete one or more of the following steps, as required:
•

To change the color of the active (working) span, go to Step 4.
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Step 4

Step 5

Step 6

Step 7

•

To change the color of the standby (protect) span, go to Step 5.

•

To return active and standby spans to their default colors, go to Step 6.

Change the color of the active span:
a.

Next to Active Span Color, click Color.

b.

In the Pick a Color dialog box, click the color for the active span, or click Reset if you want the
active span to display the last applied (saved) color.

c.

Click OK to close the Pick a Color dialog box. If you want to change the standby span color, go to
Step 5. If not, click OK to save the change and close the Preferences dialog box, or click Apply to
save the change and keep the Preferences dialog box displayed.

Change the color of the standby span:
a.

Next to Standby Span Color, click Color.

b.

In the Pick a Color dialog box, click the color for the standby span, or click Reset if you want the
standby span to display the last applied (saved) color.

c.

Click OK to save the change and close the Preferences dialog box, or click Apply to save the change
and keep the Preferences dialog box displayed.

Return the active and standby spans to their default colors:
a.

From the Edit menu, choose Preferences.

b.

In the Preferences dialog box, click the Circuits tab.

c.

Click Reset to Defaults.

d.

Click OK to save the change and close the Preferences dialog box, or click Apply to save the change
and keep the Preferences dialog box displayed.

Return to your originating procedure (NTP).

DLP-D233 Edit SNCP Circuit Path Selectors
Purpose

This task changes the SNCP signal fail and signal degrade thresholds, the
reversion and reversion time, and the PDI-P settings for one or more SNCP
circuits. This task does not apply to DWDM (Software R4.5) nodes.

Tools/Equipment

None

Prerequisite Procedures NTP-D44 Provision SNCP Nodes, page 6-32
DLP-D60 Log into CTC, page 3-23
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Click the Circuits tab.

Step 2

On the Circuits tab, click the SNCP circuit(s) you want to edit. To change the settings for multiple
circuits, press the Shift key (to choose adjoining circuits) or the Ctrl key (to choose non adjoining
circuits) and click each circuit you want to change.

Step 3

From the Tools menu, choose Circuits > Set Path Selector Attributes.
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Step 4

In the Path Selectors Attributes dialog box (Figure 11-2), edit the following SNCP selectors, as needed:
•

Revertive—If checked, traffic reverts to the working path when conditions that diverted it to the
protect path are repaired. If not checked, traffic does not revert.

•

Reversion Time (Min)—If Revertive is checked, sets the amount of time that will elapse before
traffic reverts to the working path. The range is 0.5 to 12 minutes in 0.5 minute increments.

•

SF Ber Level—Sets the SNCP signal failure BER threshold (VC4 circuits only).

•

SD Ber Level—Sets the SNCP signal degrade BER threshold (VC4 circuits only).

•

PDI-P—When checked, traffic switches if an VC4 payload defect indication is received (VC4
circuits only).

Figure 11-2 Editing SNCP Path Selectors

Step 5

Click OK and verify that the changed values are correct.

Step 6

Return to your originating procedure (NTP).
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DLP-D263 Edit SNCP Dual Ring Interconnect Circuit Hold-Off Timer
Purpose

This task changes the amount of time a path selector switch is delayed for
circuits routed on SNCP dual-ring interconnect (DRI) topology. In DRIs,
switching contention might occur depending upon the relative switching
speed of the path selector and the transmission delay on the alternative
routes. The hold-off time (HOT) allows you to change switch times to
prevent the switching contention. This task does not apply to DWDM
(Software R4.5) nodes.

Tools/Equipment

None

Prerequisite Procedures NTP-D44 Provision SNCP Nodes, page 6-32
DLP-D60 Log into CTC, page 3-23
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Click the Circuits tab.

Step 2

Click the SNCP circuit you want to edit, then click Edit.

Step 3

In the Edit Circuit window, click the SNCP Selectors tab.

Step 4

In the Holder Off Timer area, double-click the cell of the circuit span you want to edit, then type the new
hold-off time. The range is 0 to 10,000 ms in increments of 100.

Step 5

Repeat Step 4, as needed, to adjust the hold-off timer for each circuit span.

Step 6

Click Apply, then close the Edit Circuit window by choosing Close from the File menu.

Step 7

Return to your originating procedure (NTP).

NTP-D152 Delete Circuits
Purpose

This procedure deletes circuits and DWDM optical channel network
connections.

Tools/Equipment

None

Prerequisite Procedures Circuits must exist on the network. See Chapter 8, “Create Circuits and
Low-Order Tunnels.” for circuit creation procedures.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Step 1

Complete the “DLP-D60 Log into CTC” task on page 3-23 for a node on the network where you want
to delete the circuit. If you are already logged in, continue with Step 2.

Step 2

Complete the “NTP-D108 Back Up the Database” procedure on page 17-8.
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Step 3

Investigate all network alarms and resolve any problems that might be affected by the circuit deletion.
Refer to the Alarm Troubleshooting chapter in the Cisco ONS 15454 SDH Troubleshooting Guide.

Step 4

Verify that traffic is no longer carried on the circuit and that the circuit can be safely deleted.

Step 5

Click the Circuits tab.

Step 6

Choose the circuit(s) you want to delete, then click Delete.

Step 7

In the Delete Circuits confirmation dialog box, check one or both of the following, as needed:
•

Set drop ports to OOS—Puts the circuit source and destination ports out of service if the circuit is
the same size as the port or is the only circuit using the port. If the circuit is not the same size as the
port or the only circuit using the port, CTC does not change the port state.

•

Wait for feedback on drop ports —If checked, CTC displays a confirmation dialog indicating
whether or not all circuit source/destination ports were placed in OOS state. During this time, you
cannot perform other CTC functions. If you are deleting many circuits, waiting for the port OOS
confirmation might take a few minutes. Circuits are deleted whether or not this check box is
checked.

Step 8

Click Yes to confirm the deletion. If you did not check “Wait for feedback on drop ports,” the Circuits
window appears. If you checked the check box, the Circuits Window might take a few minutes to appear.

Step 9

Complete the “NTP-D108 Back Up the Database” procedure on page 17-8.
Stop. You have completed this procedure.

NTP-D78 Create a Monitor Circuit
Purpose

This procedure creates a monitor circuit that monitors traffic on primary,
bidirectional circuits on E1 of STM-1 cards. This procedure does not apply
to DWDM (Software R4.5) nodes.

Tools/Equipment

None

Prerequisite Procedures Bidirectional (2-way) circuits must exist on the network. See Chapter 8,
“Create Circuits and Low-Order Tunnels,” for circuit creation procedures.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

Monitor circuits cannot be used with EtherSwitch circuits.

Note

For unidirectional circuits, create a drop to the port where the test equipment is attached.

Step 1

Complete the “DLP-D60 Log into CTC” task on page 3-23 at a node on the network where you will
create the monitor circuit.. If you are already logged in, continue with Step 2.

Step 2

From the View menu, choose Go to Network View.

Step 3

Click the Circuits tab.
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Step 4

Choose the bidirectional (2-way) circuit that you want to monitor and double-click it (or click Edit).

Step 5

Verify that the circuit name is no more than 44 characters. Monitor circuits append a “_MON” to the
circuit name. If the name is longer than 44 characters, edit the name in the Name field, then click Apply.

Step 6

In the Edit Circuit window, click the Monitors tab.
The Monitors tab displays ports that you can use to monitor the circuit.

Note

The Monitor tab is only available when the circuit has an ACTIVE status.

Step 7

On the Monitors tab, choose the monitor source port. The monitor circuit will display traffic coming into
the node at the port you choose.

Step 8

Click Create Monitor Circuit.

Step 9

In the Circuit Destination section of the Circuit Creation wizard, choose the destination node, slot, port,
STS, VT, or DS1 for the monitored circuit.

Note

In the Figure 11-3, the monitor circuit destination is Port 2 on the STM-1 card.

Step 10

Click Next.

Step 11

In the Circuit Routing Preferences area, review the monitor circuit information. If you want the monitor
circuit routed on a MS-SPRing protection channel, click Protection Channel Access.

Step 12

Click Finish.

Step 13

In the Edit Circuit window, click Close. The new monitor circuit appears on the Circuits tab.
Figure 11-3 shows an example of a monitor circuit. At Node 1, a VC4 is dropped from Port 1 of an
STM-1 card. To monitor the VC4 traffic, test equipment is plugged into Port 2 of the STM-1 card and a
monitor circuit to Port 2 is provisioned in CTC. Circuit monitors are one-way. The monitor circuit in
Figure 11-3 is used to monitor VC4 traffic received by Port 1 of the STM-1 card.
Figure 11-3 VC4 Monitor Circuit Received at an STM-1 Port

ONS 15454 SDH
Node 1

ONS 15454 SDH
Node 2

XC

XC

VC4 Drop
Port 1

Test Set

Port 2

STM-1

STM-N

STM-N

STM-N
71678

Class 5
Switch

VC4 Monitor

Stop. You have completed this procedure.
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NTP-D79 Create a J1 or J2 Path Trace
Purpose

This procedure creates a repeated, fixed-length string of characters used to
monitor changes to circuit traffic. This procedure does not apply to DWDM
(Software R4.5) nodes.

Tools/Equipment

ONS 15454 SDH cards capable of transmitting and/or receiving path trace
must be installed. See Table 11-4 on page 11-20 for a list of J1 path trace
cards. See Table 11-5 on page 11-26 for a list of J2 path trace cards.

Prerequisite Procedures J1 path trace can be provisioned on VC3 and VC4 circuits. J2 path trace
can be provisioned on VC12 circuits. See Chapter 8, “Create Circuits and
Low-Order Tunnels,” for circuit creation procedures.
Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

Note

There are two types of J1 bytes, high-order (HO-J1) and low-order (LO-J1). The electrical cards support
LO-J1 (VC3). The optical cards support HO-J1 (VC4) and cannot monitor the LO-J1 byte.

Note

J1 path trace is available for VC3 and VC4 circuits. In ONS 15454 SDH Software R3.4 and earlier, you
can set the VC3 J1 transmit string on E3 and DS3I cards, but VC3 is not monitored by STM-N cards. J2
path trace is available for VC12 circuits.

Step 1

Complete the “DLP-D60 Log into CTC” task on page 3-23 at a node on the network where you will
create the path trace. If you are already logged in, continue with Step 2.

Step 2

Complete the following tasks as needed:
•

As needed, complete the “DLP-D264 Provision a J1 Path Trace on Circuit Source and Destination
Ports” task on page 11-20.

•

As needed, complete the “DLP-D137 Provision a J1 Path Trace on STM-N Ports” task on
page 11-24.

•

As needed, complete the “DLP-D367 Provision a J2 Path Trace on Circuit Source and Destination
Ports” task on page 11-25.

Stop. You have completed this procedure.
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DLP-D264 Provision a J1 Path Trace on Circuit Source and Destination Ports
Purpose

This task creates a J1 path trace on VC3 or VC4 circuit source ports and
destination ports. This task does not apply to DWDM (Software R4.5)
nodes.

Tools/Equipment

ONS 15454 SDH cards capable of transmitting and/or receiving J1 path
trace must be installed at the circuit source and destination ports. See
Table 11-4 on page 11-20 for a list of cards.

Prerequisite Procedures DLP-D60 Log into CTC, page 3-23

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

This procedure assumes you are setting up path trace on a bidirectional circuit and setting up transmit
strings at the circuit source and destination.

Step 1

Click the Circuits tab.

Step 2

For the VC3 or VC4 circuit you want to monitor, verify that the source and destination ports are on a
card that can transmit and receive the path trace string. See Table 11-4 for a list of cards.
Table 11-4

ONS 15454 SDH Cards Capable of J1 Path Trace

J1 Function

Cards

Transmit and receive

E1-42
STM1E-12
E3-12
DS3i-N-12
G1000-4

Receive only

OC3 IR 4/STM1 SH 1310
OC3 IR 4/STM1 SH 1310-8
OC12/STM4-4
OC48 IR/STM16 SH AS 1310,
OC48 LR/STM16 LH AS 1550
OC192 SR/STM64 IO 1310
OC192 LR/STM64 LH 1550
OC192 IR/STM SH 1550
ML100T-12
ML1000-2

If neither port is on a transmit/receive card, you will not be able to complete this procedure.
Step 3

Choose the VC3 or VC4 circuit you want to trace, then double-click it (or click Edit).
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Step 4

In the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A
detailed map of the source and destination ports is displayed.

Step 5

Provision the circuit source transmit string:
a.

On the detailed circuit map, right-click the circuit source port (the square on the left or right of the
source node icon) and choose Edit J1 Path Trace (port) from the shortcut menu. Figure 11-4 shows
an example.

Figure 11-4 Selecting the Edit Path Trace Option

78923

From network, node or card view
choose Circuits, Edit, Show Detailed Map

b.

Choose the format of the transmit string by clicking either the 16 byte or the 64 byte selection
button.

c.

In the New Transmit String field, enter the circuit source transmit string. Enter a string that makes
the source port easy to identify, such as node IP address, node name, circuit name, or another string.
If the New Transmit String field is left blank, the J1 transmits a string of null characters.

d.

Click Apply, then click Close.
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Step 6

Step 7

Provision the circuit destination transmit string:
a.

On the detailed circuit map (Figure 11-4), right-click the circuit destination port and choose
Edit Path Trace from the shortcut menu.

b.

In the New Transmit String field, enter the string that you want the circuit destination to transmit.
Enter a string that makes the destination port easy to identify, such as node IP address, node name,
circuit name, or another string. If the New Transmit String field is left blank, the J1 transmits a string
of null characters.

c.

Click Apply.

Provision the circuit destination expected string:
a.

In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual
from the Path Trace Mode drop-down menu:
– Auto—The first string received from the source port is automatically provisioned as the current

expected string. An alarm is raised when a string that differs from the baseline is received.
– Manual—The string entered in Current Expected String is the baseline. An alarm is raised when

a string that differs from the Current Expected String is received.

Step 8

b.

If you set the Path Trace Mode field to Manual, enter the string that the circuit destination should
receive from the circuit source in the New Expected String field. If you set Path Trace Mode to Auto,
skip this step.

c.

Click the Disable AIS and RDI if TIM-P is detected check box if you want to suppress the AIS
and RDI when the VC3 or VC4 High-Order Path Trace Identifier Mismatch (HP-TIM) or Low-Order
Path Trace Identifier Mismatch (LP-TIM) alarm is displayed. Refer to the Cisco ONS 15454 SDH
Troubleshooting Guide for descriptions of alarms and conditions.

d.

(Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match checkbox
if you want to suppress the Alarm Indication Signal when a C2 mis-match occurs.

e.

Click Apply, then click Close.

Provision the circuit source expected string:
a.

In the Edit Circuit window (with Show Detailed Map chosen, see Figure 11-4) right-click the circuit
source port and choose Edit Path Trace from the shortcut menu.

b.

In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual
from the Path Trace Mode drop-down menu:
– Auto—Uses the first string received from the port at the other path trace end as the current

expected string. An alarm is raised when a string that differs from the baseline is received.
– Manual—Uses the Current Expected String field as the baseline string. An alarm is raised when

a string that differs from the Current Expected String is received.
c.

If you set the Path Trace Mode field to Manual, enter the string that the circuit source should receive
from the circuit destination in the New Expected String field. If you set Path Trace Mode to Auto,
skip this step.

d.

Click the Disable AIS and RDI if TIM-P is detected check box if you want to suppress the AIS
and remote defect indication (RDI) when the VC3 or VC4 HP-TIM or LP-TIM alarm is displayed.
Refer to the Cisco ONS 15454 SDH Troubleshooting Guide for descriptions of alarms and
conditions.

e.

(Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match check
box if you want to suppress the AIS when a C2 mismatch occurs.

f.

Click Apply.
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Step 9

Caution

After you set up the path trace, the received string is displayed in the Received field on the path trace
setup window. Figure 11-5 shows an example. The following options are available:
•

Click Hex Mode to display path trace in hexadecimal display. The button name changes to ASCII
Mode. Click it to return the path trace to ASCII display.

•

Click Reset to reread values from the port.

•

Click Default to return to the path trace default settings (Path Trace Mode is set to Off and the New
Transmit and New Expected Strings are null).

Clicking Default generates alarms if the port on the other end is provisioned with a different string.
The Expect and Receive strings are updated every few seconds if the Path Trace Mode field is set to Auto
or Manual.

Step 10

Click Close.
Figure 11-5 Setting Up a Path Trace

When you display the detailed circuit window, path trace is indicated by an M (manual path trace) or an
A (automatic path trace) at the circuit source and destination ports. Figure 11-6 shows an example.
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Figure 11-6 Detailed Circuit Window With Manual Expected String Enabled

Step 11

Return to your originating procedure (NTP).

DLP-D137 Provision a J1 Path Trace on STM-N Ports
Purpose

This task monitors a path trace on VC4 high-order ports within the circuit
path. This task does not apply to DWDM (Software R4.5) nodes.

Tools/Equipment

The STM-N ports you want to monitor must be on STM-N cards capable
of receiving path trace. See Table 11-4 on page 11-20.

Prerequisite Procedures DLP-D264 Provision a J1 Path Trace on Circuit Source and Destination
Ports, page 11-20
DLP-D60 Log into CTC, page 3-23

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

To monitor the J1 path on STM-N ports, the circuit endpoints must be transmitting VC4 J1 and not
VC3 J1.

Step 1

Display the node where path trace was provisioned on the circuit source and destination ports.

Step 2

Click Circuits.

Step 3

Choose the VC4 circuit that has path trace provisioned on the source and destination ports, then click
Edit.
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Step 4

In the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A
detailed circuit graphic showing source and destination ports is displayed.

Step 5

On the detailed circuit map, right-click the circuit STM-N port (the square on the left or right of the
source node icon) and choose Edit Path Trace from the shortcut menu.

Note

Step 6

The STM-N port must be on a receive-only card listed in Table 11-4 on page 11-20. If not, the
Edit Path Trace menu item does not display.

In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual
from the Path Trace Mode drop-down menu:
•

Auto—Uses the first string received from the port at the other path trace end as the current expected
string. An alarm is raised when a string that differs from the baseline is received. For STM-N ports,
Auto is recommended because Manual mode requires you to trace the circuit on the Edit Circuit
window to determine whether the port is the source or destination path.

•

Manual—Uses the Current Expected String field as the baseline string. An alarm is raised when a
string that differs from the Current Expected String is received.

Step 7

If you set the Path Trace Mode field to Manual, enter the string that the STM-N port should receive in
the New Expected String field. To do this, trace the circuit path on the detailed circuit window to
determine whether the port is in the circuit source or destination path, then set the New Expected String
to the string transmitted by the circuit source or destination. If you set the Path Trace Mode field to Auto,
skip this step.

Step 8

Click Apply, then click Close.

Step 9

Return to your originating procedure (NTP).

DLP-D367 Provision a J2 Path Trace on Circuit Source and Destination Ports
Purpose

This task creates a J2 path trace on VC12 circuit source ports and
destination ports. This task does not apply to DWDM (Software R4.5)
nodes.

Tools/Equipment

ONS 15454 SDH cards capable of transmitting and/or receiving path trace
must be installed at the circuit source and destination ports. See Table 11-5
on page 11-26 for a list of cards.

Prerequisite Procedures DLP-D60 Log into CTC, page 3-23

Note

Required/As Needed

As needed

Onsite/Remote

Onsite or remote

Security Level

Provisioning or higher

This procedure assumes you are setting up path trace on a bidirectional circuit and setting up transmit
strings at the circuit source and destination.

Step 1

Click the Circuits tab.

Step 2

For the VC12 circuit you want to monitor, verify that the source and destination ports are on a card that
can transmit and receive the path trace string. See Table 11-5 for a list of cards.
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Table 11-5

ONS 15454 SDH Cards Capable of J2 Path Trace

J2 Function

Cards

Transmit and Receive

E1-42

Receive Only

STM1E-12

If neither port is on a transmit/receive card, you cannot complete this procedure.
Step 3

Choose the VC12 circuit you want to trace, then double-click it (or click Edit).

Step 4

In the Edit Circuit window, click the Show Detailed Map check box at the bottom of the window. A
detailed map of the source and destination ports is displayed.

Step 5

Provision the circuit source transmit string:

Step 6

Step 7

a.

On the detailed circuit map, right-click the circuit source port (the square on the left or right of the
source node icon) and choose Edit J2 Path Trace (port) from the shortcut menu.

b.

Choose the format of the transmit string by clicking either the 16 byte or the 64 byte selection
button.

c.

In the New Transmit String field, enter the circuit source transmit string. Enter a string that makes
the source port easy to identify, such as node IP address, node name, circuit name, or another string.
If the New Transmit String field is left blank, the J2 transmits a string of null characters.

d.

Click Apply, then click Close.

Provision the circuit destination transmit string:
a.

On the detailed circuit map (Figure 11-4 on page 11-21), right-click the circuit destination port and
choose Edit Path Trace from the shortcut menu.

b.

In the New Transmit String field, enter the string that you want the circuit destination to transmit.
Enter a string that makes the destination port easy to identify, such as node IP address, node name,
circuit name, or another string. If the New Transmit String field is left blank, the J2 transmits a string
of null characters.

c.

Click Apply.

Provision the circuit destination expected string:
a.

In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual
from the Path Trace Mode drop-down menu:
– Auto—The first string received from the source port is provisioned as the current expected

string. An alarm is raised when a string that differs from the baseline is received.
– Manual—The string entered in Current Expected String is the baseline. An alarm is raised when

a string that differs from the Current Expected String is received.
b.

If you set Path Trace Mode to Manual, enter the string that the circuit destination should receive
from the circuit source in the New Expected String field. If you set Path Trace Mode to Auto, skip
this step.

c.

Click the Disable AIS and RDI on J2 TIM check box if you want to suppress the AIS and RDI
when the LP-TIM alarm is displayed. Refer to the Cisco ONS 15454 SDH Troubleshooting Guide
for descriptions of alarms and conditions.

d.

Click the Disable AIS on LO SLM check box if you want to suppress the AIS when the Low-Order
Signal Label Mismatch (LO SLM) alarm is displayed. Refer to the Cisco ONS 15454 SDH
Troubleshooting Guide for descriptions of alarms and conditions.
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Step 8

e.

(Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match check
box if you want to suppress the AIS when a C2 mismatch occurs.

f.

Click Apply, then click Close.

Provision the circuit source expected string:
a.

In the Edit Circuit window (with Show Detailed Map chosen, see Figure 11-4 on page 11-21)
right-click the circuit source port and choose Edit Path Trace from the shortcut menu.

b.

In the Circuit Path Trace window, enable the path trace expected string by choosing Auto or Manual
from the Path Trace Mode drop-down menu:
– Auto—Uses the first string received from port at the other end as the current expected string.

An alarm is raised when a string that differs from the baseline is received.
– Manual—Uses the Current Expected String field as the baseline string. An alarm is raised when

a string that differs from the Current Expected String is received.

Step 9

Caution

c.

If you set the Path Trace Mode field to Manual, enter the string that the circuit source should receive
from the circuit destination in the New Expected String field. If you set the Path Trace Mode field
to Auto, skip this step.

d.

Click the Disable AIS and RDI on J2 TIM check box if you want to suppress the AIS and RDI
when the LP-TIM alarm is displayed. Refer to the Cisco ONS 15454 SDH Troubleshooting Guide
for descriptions of alarms and conditions.

e.

Click the Disable AIS on LO SLM check box if you want to suppress the alarm indication signal
when the LO SLM alarm is displayed. Refer to the Cisco ONS 15454 SDH Troubleshooting Guide
for descriptions of alarms and conditions.

f.

(Check box visibility depends on card selection) Click the Disable AIS on C2 Mis-Match check
box if you want to suppress the AIS when a C2 mismatch occurs.

g.

Click Apply.

After you set up the path trace, the received string is displayed in the Received field on the path trace
setup window. The following options are available:
•

Click Hex Mode to display path trace in hexadecimal display. The button name changes to ASCII
Mode. Click it to return the path trace to ASCII display.

•

Click Reset to reread values from the port.

•

Click Default to return to the path trace default settings. (Path Trace Mode is set to Off and the New
Transmit and New Expected Strings are null.)

Clicking Default generates alarms if the port on the other end is provisioned with a different string.
The Expect and Receive strings are updated every few seconds if the Path Trace Mode field is set to Auto
or Manual.

Step 10

Click Close.
When you display the detailed circuit window, path trace is indicated by an M (manual path trace) or an
A (automatic path trace) at the circuit source and destination ports.

Step 11

Return to your originating procedure (NTP).
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